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1. Product Overview

The RinTex-CEWB series wireless channel simulator is a high-
performance wireless communication link simulation device. It simulates real-
world space communication environments in laboratories and constructs high-
precision, wide-bandwidth RF channel switching networks. The simulator
dynamically simulates wireless channel characteristics in communication links,
including transmission delay, Doppler frequency offset, amplitude attenuation,
multipath, and fading models. It enables device-level and network-level wireless
channel simulation, supporting R&D, verification, and testing tasks.

As a core component in modern electronic warfare and communication
testing, the channel simulator is a high-fidelity simulation platform specifically
designed to validate communication and countermeasure system performance in
complex battlefield environments. This system accurately replicates the dynamic
and multifactorial channel conditions of real combat scenarios, providing critical
support for the development, testing, and training of various communication
devices, countermeasure equipment, and electronic warfare systems.

The system simulates typical channel characteristics including multipath
fading, Doppler effect, terrain effects, and weather influences, enabling the
creation of comprehensive combat scenarios that integrate countermeasures,
communication devices, background signals, and jamming equipment. Through
flexible configuration, users can replicate high-intensity electromagnetic warfare
scenarios such as communication link testing under severe interference, anti-
jamming performance evaluation, complex signal recognition, and
electromagnetic game theory.

The platform is widely used in equipment acceptance, protocol verification,
tactical research and system integration testing, which solves the problems of
high cost, limited conditions and difficulty in repetition of field combat testing,
and enables researchers and trainees to effectively evaluate and improve the

combat effectiveness of equipment in extreme battlefield environment in a
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controllable laboratory environment.

2. Product Application

® Wireless Communication Link Simulation and Test

® semi-physical simulation test

® Massive MIMO simulation test

® Complex Electromagnetic Environment Simulation Test
® Simulation and Test of Data Chain Communication

® satellite network simulation test

3. product function

® The system supports wireless channel model editing, including
multipath configuration, delay, fading channel, Doppler shift, and SNR
simulation. In full-network mode, all communication links' delay,

frequency offset, fading, and multipath are independently configurable.

® channel model :

< Supports constant, Rayleigh, Rice, Nakagami, flat, circular arc,

double Gaussian, Lognormal, Suzuki, pure Doppler, and Bartwitz;

¢

Supports shortwave communication (ITS) and Watterson model.

< Supports simulation of electromagnetic wave propagation modes
such as skywave and ground wave.

< Supports the impact of weather conditions such as atmosphere, rain,
and snow on channel characteristics;

< Supports user-defined channel model loading;

@ It can be interconnected with external storage devices via 10G network,
receive baseband data, perform channel simulation, and output through
the RF interface or return to the storage device; alternatively, it can store
the collected RF input signals into the storage device.

@ Supports multi-channel editing of various wireless network topologies,
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including linear, star, fully connected, and multi-subnet configurations.

@ Supports receiving software control from other platforms through

Ethernet interface.

® Supports dynamic simulation, including Doppler shift, time delay, and

power.

@ It can receive external B (DC) code to synchronize the entire system.

@ It has narrowband jamming, broadband jamming, comb jamming,

4. qualification

frequency hopping jamming, sweep jamming and pulse jamming;

order
Indicators qualification remarks
number
1. number of channels 8 input, 8 output
2. frequency range 200MHz ~ 6GHz
3. tape width 500MHz
4. input signal power range -40dBm ~ 30dBm
5. output signal power range -120dBm ~ 0dBm
6. output signal power resolution 0.1dB
7. output signal power accuracy 1dB@=-90dBm
8. banding Better than 40dBc
dynamic range of multipath
9. Y 8 P Sus ~ 600ms
delay
10. standing-wave ratio <16
11. interchannel isolation Better than 120dB
maximum Doppler frequenc
12. PP Aueney +3MHz
offset
maximum rate of change of
13. >80KHz/s
Doppler shift
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14. ground noise <-160dBm/Hz@Typical value
15. User-defined model support
16. Import STK files support
Supports AWGN, CW, and other
17. noise disturbance model formats
interference simulation
Supports free-space fading, shadow
fading, multipath delay, Rayleigh, Rice,
18. fading channel model and Doppler characteristics (flat, arc,
Gaussian, dual-Gaussian).
Constant, Nakagami,
Lognormal
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5. solution architecture

5.1. Device configuration

The channel simulator hardware platform employs a standard VPX modular
architecture, primarily consisting of a signal processing unit, an 8-channel signal
transceiver unit, and a clock synchronization unit. It utilizes a professional main
controller, high-speed backplane, and power unit as the operational platform. The
entire hardware system is equipped with industrial-standard peripheral devices,
housed in a standard 19-inch rack-mounted chassis, and supported by a fully
functional software platform. Together, these components ensure the system's high

performance and reliability.
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Figure 51 Schematic diagram of device composition

The basic functions of each unit are as follows:

» 8-channel signal transceiver unit

Each 8-channel signal transceiver unit is composed of 8 RF signal receiving
links and 8 RF signal transmitting links.

The RF signal receiving link performs signal reception, orthogonal down-
conversion, and baseband sampling. The RF signal input through the receiving port
undergoes signal conditioning, filtering, and analog-to-digital (AD) conversion before
being converted to baseband signals for transmission to the signal processing unit.

Each signal channel is equipped with a frequency synthesis module, allowing
29
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independent frequency control. This configuration enables each receiving channel to
operate at distinct frequencies.

The RF signal transmission chain performs digital-to-analog conversion,
orthogonal up-conversion, and RF signal emission. The received signal processing
unit processes the baseband signals transmitted from the source, executing DAC
conversion, up-conversion, and gain control before output through the RF port. Each
signal channel is equipped with an independent frequency synthesis module, enabling
frequency customization. This configuration supports independent operation of
transmission channels at distinct frequencies.

» signal processing unit

The system connects to the 8-channel signal transceiver unit via the VPX
backplane connector. It receives digital signals from the RF receiver unit through the
high-speed SERDES transmission bus, performing functions such as delay, Doppler
simulation, attenuation, phase shift, and multipath simulation. The signals, after being
processed through the superimposed channel model, undergo digital interpolation and
filtering. Finally, the digital signals are transmitted to the RF transmitter unit via the
VPX interface.

The system's synchronization processing is implemented through a signal
processing card. Upon receiving external synchronization signals or synchronization
commands from the host computer software, the card simultaneously distributes them
to all RF receiving and transmitting units, enabling synchronized system control. The
card can receive B-code signals from the Beidou timing unit, parse them, and
synchronize the system clock with the Beidou system. When no external Beidou
signal is available, the channel simulator uses the clock from the host control
software's system as the system clock.

» clock synchronization unit

Responsible for the clock synchronization and time synchronization of all
modules in the channel simulator mainframe.

» Dbackplane unit
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The backplane unit has the following functions:

High-speed signal exchange: to realize the multi-channel high-speed signal
exchange;

Clock transmission: provides the operating clock for each signal processing card.

Synchronous trigger control: The trigger signal is introduced into each carrier
plate.

Power distribution: supplies operating voltage to each independent module.

» power subsystem

The power unit converts external AC power into DC power through AC-DC
conversion, supplying 220V mains voltage to all boards and modules.

» main control unit

The main control unit runs the device control software and analysis subsystem,
which is responsible for the display, alarm, control and self-test of the wireless
channel simulator, providing the external interactive interface, and accomplishing the
control, monitoring and self-test of the system components. It provides the operating
platform for the system control software and the human-machine interaction software.

The software platform is integrated into the main control unit, running
underlying drivers, channel simulation software, and a human-machine interface. It
provides the channel simulator's underlying drivers and software environment,
executes channel simulator applications, and performs functions including
configuration file management, test channel selection, system parameter
configuration, system operation control, and user interface. Users configure system
parameters and access help functions through the software interface, while the LCD

screen displays system status and abnormal alarms for real-time monitoring.

5.2. mechanism of operation

The channel simulator operates on the principle of "software-defined damage,
hardware-executed in real time." By converting complex electromagnetic wave
propagation phenomena into computable digital models and processing signals in real

time through pipeline operations on powerful hardware platforms, it successfully
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encapsulates the vast, uncontrollable real-world wireless environment within a
compact laboratory chassis. This innovation provides an indispensable testing

foundation for the rapid advancement of wireless communication technologies.

5.2.1. Core Principles and System Composition

The core mission of a channel simulator is to accurately replicate the various
signal degradation effects of real-world wireless channels in a controlled laboratory
environment. Its operation is based on a key concept: transforming an ideal digital
baseband signal into one that has experienced real-channel fading, delay, and
interference through a software-defined, hardware-implemented channel degradation
model.

During channel simulation, channel characteristics must be analyzed based on
test environments, terminal positions, and motion trajectories. The distance between
terminals manifests as time delay and signal attenuation, while relative motion results
in Doppler shift and Doppler spread. Changes in terminal positions cause signal
routing variations. Different simulation environments correspond to distinct multipath

quantities and fading types.

The core components and data flow are shown in the figure

below:
—10MHZEIN e w
< 10MHZE B =] 25 BT
v ISR v

ESaE
B
& EHHIIR

R R ERET

FIRAKM

usB

-t

VGA/HDMI

-
¢

220vER R

RIRETE

29




siEF S
RINFON specification
—10MHZHIN = —
< 10MHZE B =] 25 BT
v El R4 v
— el I

ESaE
B
& EHHIIR

R R ERET

FIRIAKM

usB

-t

-
¢

VGA/HDMI

-
¢

220vER R

RIRETE

Figure 52 Schematic diagram of device working principle
The RF module group handles up-conversion from baseband to RF signals and

down-conversion from RF to baseband signals, with 32 up/down physical channels.
Each channel operates at an independently configured frequency.

The signal processing board enables channel simulation. A single board
integrates four FPGA chips to simulate 1 input signal and multiple output channels,
while two boards work together to simulate 16 input signals and multiple output
channels. The boards are interconnected via fiber optic interfaces for seamless data
exchange.

The clock synchronization module provides the synchronization clock for the
whole system, ensuring the phase consistency of each channel.

The backplane unit supplies power to each hardware board and provides high-
speed interconnection between boards.

The master control module runs the host computer software and controls the

whole system through PCle.

5.2.2. Detailed Operating Mechanism and Signal Processing Flow

The channel simulator features 16 RF channels and supports both multi-link and

networking modes. In multi-link mode, all signal input/output ports are numbered
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sequentially (e.g., IN1->OUT1, IN2->0OUT?2,..., INX->OUTX). Networking mode
allows all input signals to be output through any interface, with various channel

characteristics layered between them.
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Figure 53 8-channel signal networking
The signal processing workflow for each link is illustrated in the figure below.
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Figure 54 Single-link Signal Processing Flowchart
The signal processing flow is as follows:

=91 | ——

The external RF signal input is configured according to the user's preset
frequency and bandwidth parameters of the input signal, which completes the
orthogonal transformation, filtering and signal amplitude conditioning of the RF
signal to meet the sampling requirements of the ADC in the digital signal processing
unit.

Each channel performs channel simulation processing on the received signals,
such as: large delay, small delay, multipath simulation (relative delay, attenuation,
fading), Doppler simulation, interference simulation, amplitude attenuation, etc.

The signal synthesis is carried out to achieve the superposition of multiple
signals. Then the analog 1Q signal is output through the DAC.

The RF transmitter module performs up-conversion and amplitude modulation

of analog signals and outputs them.

6. equipment structure design

6.1. Product form

The channel simulator platform is designed with a standard 6U chassis, featuring
a custom backplane to enable high-bandwidth signal transmission between boards.
All modules are integrated into a single standard rack-mounted chassis. The modular

design facilitates easy assembly and disassembly, enabling rapid fault diagnosis and
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resolution.

The device features a clean and understated design with high-quality materials.
Its exterior is spray-painted for aesthetic appeal and wear resistance, while the overall
color scheme harmonizes beautifully with the surrounding environment. See the

schematic diagram of the narrowband wireless channel simulator's design below:

Figure 61: Exterior view of the chassis
6.2. external interface

The device's external interfaces primarily include RF channel interface,
reference clock interface, trigger signal interface, remote control communication
interface, time synchronization signal interface, and power supply interface, as shown

in the figure below.
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Figure 62 Schematic diagram of the device's external interfaces
Table 61 External Interface Table

order
Interface name interface type | explain
number

8 input interfaces:

1 RFI1~RFI8 SMA The 1.5MHz~6GHz channel utilizes an SMA
interface.
8-channel RF output interface:

2 RFoutl~RFout8 SMA The 1.5MHz~6GHz channel utilizes an SMA
interface.

3 gigabit Ethernet RJ45 1 Gigabit Ethernet Control Interface

4 CLK IN SMA External 10MHz/100MHz reference clock input

5 CLK OUT SMA Internal 10MHz reference clock output

6 HDMI HDMI HD video interface

7 USB USB 4 USB 3.0 ports

National

220V power input interface for the entire

8 source Standard Three- _
machine

Pole Socket
9 TRIGIN SMA Trigger input, 1.8V or 3.3V TTL available
10 TRIGOUT SMA Trigger output, 3.3V TTL
time system RS422 level, used for receiving time
11 _ DBY9 S
interface synchronization signals

7. Software interface display

7.1. Create Simulation
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7.1.1. essential parameter
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Figure 71 Basic Parameters
The basic parameter page sets the simulation parameters, with the following

specific meanings.

Interface parameter declaration
parameters
name Create a simulation file name to display during simulation run or editing.

description | Brief description of the simulation file.

Work path | Simulation file storage path.

channel The simulation channel bandwidth selection supports 40 MHz, 120 MHz, 250
bandwidth | MHz, and 500 MHz.

performance| Simulation runtime duration. Set '-1' to run continuously until the user stops
period the simulation manually.

simulation | networking| It realizes the network communication between multiple
mode terminals.

multilink | Multiple links are implemented with each link's channel
characteristics individually defined, ensuring independence
between links.
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1.1.1. channel model
The interface of channel model mainly sets the parameters of the simulation link
such as delay, Doppler and other trajectory parameters, and the model parameters of
the channel model and shadow model.
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Figure 72: Channel Model Interface

The parameter descriptions are shown in the table below.

Interface parameter declaration
parameters

trajectory standard track | The trajectory mode supports delay, Doppler, Doppler
parameter
# one change, Doppler # two change, distance,

velocity, acceleration, and acceleration acceleration

mode for trajectory design.

Change modes include fixed, linear, sine, and custom.
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Offline Import STK and WI software to save trajectory files.
trajectory
channel channel model | Select a channel model or create a standard channel
parameter model.

shadow model | Enable shadow fading, whether the channel model
considers the shadow effect to switch;

Select a shadow model or create one.

atmospheric | The atmospheric parameters enable the channel model to consider the
parameter | influence of atmospheric effects on the switch.
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Figure 73 User-defined channel model selection

Output port, where you can set the output power, group delay, and interference

parameters of this link
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Figure 74 Output Port Settings

The input port power and frequency can be set in the same input port.
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e 75 Input Port Settings

7.1.2. Confirm variables
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Figure 75: Confirmed variables

The confirmation variable interface is actually a summary interface where you

can view most of the channel information you set up earlier. After confirmation, you

can switch to the simulation interface.

7.2. run simulation

There are three ways to enter the operation simulation interface:

@ Home, Run Simulation;

® Run Simulation in the menu bar;

® To start the simulation, confirm the variables, and click Complete to open

the simulation interface.

The simulation interface menu bar consists of functional modules: File,

Operation, Simulation Settings, Window, and Log. The File module manages

simulation files, including opening and closing operations. The Operation module

controls the start and stop of simulation chains. The Window displays simulation

settings and waveform, with the settings module allowing modification of parameters

during simulation. The Window serves as the waveform display area for simulation
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curves, while the Log module shows system abnormal states.

7.2.1. document

® Open: Select the simulation file;
® Close: Close the current open simulation file.
™ Save: Click Save to save the modified configuration for future reference.

® Save as: Supports saving rsim files.

® Recent files: Files you've accessed recently for quick access.

B g X

FF =FA Fa =R
X #

Figure 76 File Operation Icon Bar

7.2.2. operate

Figure 77: Operation Icon Bar

® Run: Run simulation;

® Pause: Simulates the current state without updating CIR, while hardware
maintains the parameters as at the pause moment.

@ Stop: End this simulation;

@ Trigger settings: Choose from multiple trigger modes (default, network,

external, or scheduled) based on user requirements.

7.2.3. Simulation Settings

The link can modify the *signal center frequency, trajectory parameters,
channel model and atmospheric parameters.
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Figure 78: Operation Simulation Parameter Link Configuration Interface

The input port can set the power of the channel simulator input port.
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Figure 79: Input settings boundary for operational simulation parameters

The output port can set the power of the input port of the channel simulator.
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Figure 710: Output settings interface for operational simulation parameters

7.2.4. waveform display
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Figure 711 Waveform display
The shortcut icon "Waveform Display" switches to the Run Simulation>
Waveform Display interface. In the View menu bar, click "Chart Layout"> "Add
Chart" to customize the display page layout.
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7.3. Model Tools

Model tools create or edit channel models and shadow models.

7.3.1. document

@ Open: Select the simulation file;

@ Close: Close the current open simulation file.

® Save: Click Save to save the modified configuration.
® Save as: Supports saving rsim files.

® Recent files: Files you've accessed recently for quick access.

7.3.2. Custom Model (.tap)

Go to File> New, as shown below
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Create a new 712 model tool
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Figure 713: Model Tool-New Channel Model Basic Parameters Interface

The interface of the new channel model created by the model tool is divided into

three parts: the model file path display area, the channel impulse response schematic

display area, and the interface parameter display area. The interface parameters are

introduced as follows.

Interface parameter declaration
parameters
es | Model name | Create channel model name
S¢ | types of An independent channel refers to a channel without correlation;
| models

nti this function is selected when the simulated channels exhibit
al correlation, and can be adjusted based on the degree of
pa correlation.
a Edit the corresponding channel correlation matrix in the radius parameters
m (this feature is retained in the current version)

Doppler The maximum Doppler spread is S00KHz. If you select trajectory
et | expansion calculation, set this parameter.

The set value is invalid. The extended value is calculated based on
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er the actual trajectory parameters.
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Figure 714: Interface of Multipath Parameters for Channel Model
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Figure 715: Multipath Parameter Editing Interface for Channel Model

"Add" or "Delete" increases or decreases the number of multipath routes, with a
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maximum of 24 routes supported. Select a route and click "Edit" to modify its
parameters.
After editing, click OK to save. The relevant parameters in the multipath

parameter editing interface are as follows:

Interface parameters parameter declaration

m | path delay Supports three multipath relative delay methods: fixed, linear, and|
sine, with multipath relative.

ult
Maximum delay: 20us

ip : : : .

average amplitude| Supports three multipath amplitude attenuation modes: fixed,

at | attenuation linear, and sine, with an attenuation range.

h 0—o60dB

pa decline model It provides four fading modes: direct, Rayleigh fading, Rice

fading, and pure Doppler.

fa | angle of arrival The angle between the direction of the incoming wave and the
receiver's movement direction ranges from-180° to 180°.

m

et 180°

er | direct and The ratio of the direct-view diameter #:to the average power of other
scattered diameters, where a smaller value indicates stronger direct-view
work diameter.
H compare

phase deviation | phage difference between multipaths, range-180° to 180°
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correlation You can browse or edit the photo only after selecting the
characteristic

relevant channel in the basic parameters.

Guan matrix

7.3.3. Shadow Model (.shd)

Go to the New menu, as shown below.
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Figure 716: Multipath Parameter Editing Interface for Channel Model

Select a model type, click OK, and the new model interface will appear as
shown below
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Figure 717 Shadow Model Editing Interface

After editing the shadow model, click Save to save it, or click Save As to choose
a path.

Shadow Model Parameter Description

Interface | parameter declaration
parameters

Model Edit the shadow model name
name

types of The shadow model supports five types: Lognormal, Sawtooth, Sine, Triangle,
models and Custom.

Shadow types and corresponding simple diagrams are available in the
workspace during setup.

time Keep. The configuration will be $updated and unified when needed.
resolution

Lognormal parameter configuration
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standard Describe the distribution of decay values. A larger value indicates a
deviation greater deviation from the average.
Relevant Describe the time correlation of the Lognormal model. The average decay
length of Lognormal depends on
Standard deviation (retained)

Parameter configuration of sawtooth wave and triangular wave

origin Describe the initial value of shadow model attenuation

terminal Describe the maximum attenuation value for this shadow model setting
point

period The complete cycle time of a sawtooth wave or triangular wave

Sinusoidal wave parameter configuration

mean Mean value of sine shadow attenuation amplitude

range The magnitude of variation above and below the mean
period The time it takes for a sine wave to complete one full cycle
epoch Initial phase of the sine wave variation

Custom shadow models can be set directly on the interface as shown in the

figure below, or imported from external data.
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Figure 718 Custom Shadow Model Editing Interface

7.3.4. 3GPP model (. gpp)

Click the New menu, as shown below.
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Figure 719 3GPP New Interface

The 3GPP model comprises two types: 3GPP-CDL and 3GPP-TDL.
The 3GPP-CDL is categorized into: CDL_A, CDL_B, CDL C, and CDL_D.

3GPP-TDL is categorized into four types: TDL_A, TDL B, TDL C, and
TDL D.
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Figure 720 CDL type
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Figure 721 TDL type

The parameters include channel parameters, terminal parameters and satellite

parameters.
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7.3.5. ITU-R Space Terrestrial Link Transport Model (ITU-R)

Click the New menu, as shown below.
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Figure 722 RTU-R Space-to-Earth Link Model New Interface

The RTU-R space-ground link model is classified into: P.618, P.619, P.676,
P.681
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Figure 723 Classification of RTU-R Space-to-Earth Link Models

The parameters include: type, ground station parameters and satellite parameters.

7.3.6. Classic Satellite Model (.cla)

Go to the New menu, as shown below.

(SRR S
E =] edEe 31511 iETFR #wETE
i U B @ X =

R 7 &F 5% XA =BOW

X %




B5E¥
RINFON specification

Figure 724 Classic Satellite Model

The classic satellite models include: Loo, Corazza, Abdi, Lutz, and LRR.
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Figure 725 Classification of Classic Satellite Models
Parameter settings include type and LRR model.

7.3.7. COST207-large scale model (.lar)
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Figure 726 COST-207 Large-scale fading model

COST-207 Large-scale fading model classification parameter setting

SIS i _Sa
0 ORGA  ECHA SR

i U B g X =

R A7 &5 S55h A BOoW

X %

AREEER

wRER 2023-08-15-11-37-08
COST207

COsT207 TEREHRE (RA

EfTEE:

Figure 727 COST-207 Large-scale fading model
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7.4. real-time trajectory

The system can process real-time data from third-party software and transmit
satellite-to-ground link data, simulating the actual radio frequency link between

satellites and ground stations.

7.4.1. channel software settings

Select 'Real-time Trace' in the link parameter field to configure input/output port

frequency and power.
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Figure 728 Real-time Trajectory Settings Page

7.4.2. Third-party software settings

Create a scene and add satellites, ground stations, user terminals, antennas, and
links. The number of added links and center frequency must match the settings in the

channel simulator software.
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Figure 729 Third-party software settings page
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